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บทคัดย่อ 

การวิจัยครั้งนี้มีวัตถุประสงค์เพื่อศึกษาการใช้ประโยชน์ที่ดินพื้นที่ป่าชายเลนปี พ.ศ. 2545 2552 และ ปี พ.ศ. 2560 
บริเวณพื้นที่ระหว่างปากแม่น้้าเจ้าพระยาถึงปากแม่น้้าบางปะกง  พื้นที่ที่ศึกษา คือพื้นที่ที่ติดกับป่าชายเลนในจังหวัด
สมุทรปราการ และจังหวัดฉะเชิงเทรา ซึ่งได้แก่ ต้าบลบางปะกง ต้าบลสองคลอง อ้าเภอบางปะกง จังหวัดฉะเชิงเทรา 
ต้าบลบางปูใหม่ ต้าบลบางปู อ้าเภอเมืองสมุทรปราการ และต้าบลคลองด่าน อ้าเภอบางบ่อ จังหวัดสมุทรปราการ  
การศึกษาครั้งน้ีใช้ข้อมูลภาพถ่ายดาวเทียม ปี พ.ศ. 2545 2552 และ ปี พ.ศ. 2560 ระบบสารสนเทศภูมิศาสตร์จ้าแนกการ
ใช้ประโยชน์ที่ดิน และวิ เคราะห์การเปลี่ยนแปลงของป่าชายเลนปี  พ.ศ. 2545 2552 และ ปี พ.ศ. 2560  

ผลการศึกษาพบว่าพื้นที่ที่เป็นป่าชายเลน ชุมชนเมือง และอุตสาหกรรมจากปี พ.ศ.2545 ถึง 2560 มีแนวโน้มเพิ่มขึ้น 
ในขณะที่พื้นที่ใช้ประโยชน์ด้านเกษตรกรรมกลับมีแนวโน้มลดลง มีความสอดคล้องกับยุทธศาสตร์กระทรวง
ทรัพยากรธรรมชาติและสิ่งแวดล้อม ระยะ 20 ปี ประเด็นยุทธศาสตร์ที่ 1 การจัดการป่าไม้และความหลากหลายทาง
ชีวภาพ 

 

ค้าส้าคัญ: การใช้ประโยชน์ท่ีดิน, ป่าชายเลน, ระบบสารสนเทศภมูศิาสตร์, แม่น้้าเจ้าพระยา, แม่น้้าบางปะกง 
 

Abstract 
 This research aims to study land use in 2002, 2009, and 2017 by using the Geoinformation 
Technology around the area between the mouth of the Chao Phraya River to the mouth of the Bang 
Pakong River. The study area was from Ban Nai Klong coastal in Samut Prakarn to Kao Nok in 
Chachoengsao. This study uses satellite imagery data in 2002, 2009 and 2017. Geographic Information 
System (GIS) was used to classify land use and analyse of mangrove changes in 2002, 2009, and 2017. 
The results showed that mangrove areas, urban areas and industrial areas from 2002 to 201 were likely 
to increase. Meanwhile, the agricultural area is likely to decline. 
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ความเป็นมาและความส้าคัญของปัญหา 
ประชากรเกือบครึ่งหนึ่งของโลก (44%) อาศัยอยู่ภายในบริเวณ 150 กม. จากชายฝั่ง (Upadhyay, Ranjan, & Singh, 2002) การ

ที่เขตชายฝั่งมีประชากรหนาแน่นได้กระตุ้นให้มีการบุกรุกพื้นที่ป่าชายเลนอย่างกว้างขวางเพื่อการพัฒนาชายฝั่ง เช่น การเพาะเลี้ยงสัตว์น้้า
หรือการใช้ทรัพยากร อีกทั้งสัตว์ที่มีถิ่นที่อยู่อาศัยในป่าชายเลนมีเกณฑ์เสี่ยงสูงที่จะสูญพันธุ์เนื่องจากการสูญเสียแหล่งที่อยู่อาศัยที่
กว้างขวาง (Luther & Greenburg, 2009) นอกจากนี้ประมาณ 26% ของป่าชายเลนทั่วโลกเสื่อมโทรมเนื่องจากการใช้ประโยชน์จากไม้และ
ไม้ซุงที่มากเกินไป (FAO ,2003) ในท้านองเดียวกันการเพาะเลี้ยงกุ้งมีส่วนท้าให้เกิดการสูญเสียป่าชายเลนทั่วโลกประมาณร้อยละ 38 
ยกตัวอย่างในอินเดียเพียงพื้นที่ป่าชายเลนมากกว่า 40% ของบนชายฝั่งตะวันตกได้รับการเปลี่ยนแปลงให้เป็นการเกษตรและการพัฒนา
เมืองชายฝั่ง (Upadhyay, et.al, 2002; FAO, 2003) รายงานถึงสถานการณ์ของพื้นที่ป่าชายเลน โดยประมาณร้อยละ 20 ได้สูญหายไปตั้งแต่
ประมาณปี   พ. ศ. 2523 และพื้นที่ป่าชายเลนจะหายไปในอัตราประมาณ 1% ต่อปี (FAO, 2003) ปัจจุบันคาดว่าอัตราการใช้ประโยชน์
ที่ดินในบริเวณป่าชายเลนจะยังคงมีอยู่ต่อไปเว้นแต่ป่าชายเลนจะได้รับการคุ้มครองเป็นทรัพยากรที่มีค่า  เนื่องจากความจ้าเป็นที่จะต้อง
สนองตอบความต้องการของประชากรที่เพิ่มขึ้นตามที่กล่าวมาแล้วนั้น จะต้องใช้ทรัพยากรหลายอย่างรวมถึงการใช้พื้นที่ซึ่งเป็นปัจจัย
ส้าคัญพื้นฐานในการตั้งที่อยู่อาศัยและตั้งพื้นที่อุตสาหกรรมท้าให้เกิดการรุกเข้าไปยังพื้นที่ส่วนต่างๆ  รวมถึงพื้นที่ที่ไม่ควรจะเป็นแหล่งที่
อยู่อาศัย แหล่งอุตสาหกรรม เช่น พื้นที่ป่าไม้ พื้นที่ชุ่มน้้า แหล่งที่มีความส้าคัญของระบบนิเวศวิทยา ท้าให้เกิดปัญหาทางด้านความ
ขัดแย้งในการใช้พื้นที่ ที่เกิดจากประชากรที่อยู่อาศัยในพื้นที่กับภาครัฐและเอกชน ที่มีความต้องการในการใช้พื้นที่ ที่แตกต่างกัน มีการ
ประกาศนโยบายการบริหารจัดการของภาครัฐ มีการเข้าถือครองพื้นที่ของภาคเอกชน เพื่อใช้ในภาคอุตสาหกรรม ความต้องการใช้พื้นที่ของ
พื้นที่ของประชากรเดิมในพื้นที่ เป็นส่วนที่ท้าให้เกิดการบุกรุกเข้าใช้พื้นที่ในลักษณะที่ต่างกัน 

วิกฤตของป่าชายเลนในประเทศไทยที่เกิดขึ้นสอดคล้องกับการรายงานผลของ (FAO, 2013) ที่ได้กล่าวถึงป่าชายเลนเป็นหนึ่งใน
ระบบนิเวศบกที่มีประสิทธิภาพมากที่สุดและเป็นแหล่งทรัพยากรธรรมชาติที่เป็นประโยชน์ต่อธรรมชาติ อย่างไรก็ตามป่าชายเลนของโลก
ก้าลังถูกบุกรุกซึ่งเกิดจากกิจกรรมของมนุษย์นอกจากป่าชายเลนก้าลังสูญเสียแหล่งที่อยู่อาศัยของพวกเขาเนื่องจากแม่น้้าถูกกักเก็บน้้า
และเขตน้้าท่วมเพื่อการเพาะเลี้ยงสัตว์น้้าและแห้งแล้งโดยทั่วไปแล้ว  พื้นที่ป่าชายเลนในบางพื้นที่ยังได้รับการเปลี่ยนแปลงเป็นนาข้าว บ่อ
ปลา และบ่อกุ้ง  การพัฒนาที่ดินสู่ภาคอุตสาหกรรม ในเอเชียบางประเทศพื้นที่ป่าชายเลนยังถูกใช้มากเกินไปส้าหรับการผลิตไม้ฟืนและ
ถ่านในพื้นที่ท่ีขาดแคลนไม้เนื้ออ่อนเพื่อมาเป็นเช้ือเพลิงในประเทศ นอกจากนี้“เนื่องจากอัตราการสูญเสียที่เพิ่มขึ้นป่าชายเลนอาจหายไป
อย่างน้อยหนึ่งร้อยปีข้างหน้า” (Duke, Meynecke, Dittmann, Ellison, and Anger, 2007) จากการสูญเสียพื้นที่ป่าชายเลนส่งผลให้เกิด
ความกังวลด้านสิ่งแวดล้อมและเศรษฐกิจอย่างร้ายแรงต่อประเทศยกตัวอย่างจากข้อเท็จจริงที่ว่าบริเวณรอยต่อระหว่างทะเลและป่าชาย
เลนมีบทบาทส้าคัญในการบรรเทาอุทกภัย น้้าท่วม และมรสุม นอกจากนี้การลดลงของทรัพยากรที่ส้าคัญนี้จะท้าให้ลดการผลิตสัตว์บก
และสัตว์น้้าและที่อยู่อาศัยของสัตว์ป่า แต่ที่ส้าคัญกว่าคือความมั่นคงด้านสิ่งแวดล้อมของป่าชายฝั่งที่จะช่วยป้องกันพืชผลทางการเกษตร
ในการป้องกันลม และคลื่นทะเล ป้องกันน้้าเซาะเข้ามาในพื้นที่เกษตรกรรมในบริเวณใกล้เคียง  

จังหวัดฉะเชิงเทรามีพื้นที่ป่าชายเลนที่ส้าคัญและมีปริมาณมากที่สุดคือในเขตอ้าเภอบางปะกง ซึ่งตามรายงานของกรม
ทรัพยากรทางทะเลและชายฝั่ง (2555) ได้แสดงให้เห็นถึงการใช้ประโยชน์ที่ดิน โดยแบ่งเป็นพื้นที่ป่าชายเลน 6,992.81 ไร่ นากุ้ง 
601.64 ไร่ เกษตร 10,472.26 ไร่ อื่นๆ 11,973.87 ไร่ เช่นเดียวกันกับในจังหวัดสมุทรปราการ บริเวณปากแม่น้้าเจ้าพระยา ในอ้าเภอ
เมืองสมุทรปราการและอ้าเภอบางบ่อ มีพื้นที่ป่าชายเลนที่ถูกใช้ประโยชน์โดยแบ่งเป็นพื้นที่ป่าชายเลน 3,639.36 ไร่ นากุ้ง 358.29 ไร่ 
เกษตร 3,583.68 ไร่ อื่นๆ 18,329.11 ไร่ การใช้ประโยชน์ท่ีดินในพืน้ที่ป่าชายเลนของทั้งสองจังหวัดช้ีให้เห็นว่ากิจกรรมต่างๆไม่ว่าจะ
เป็น การเกษตร นากุ้ง หรืออื่นๆซึ่งอาจเป็นการใช้ที่ดินเพื่อการอุตสาหกรรมและการท่องเที่ยวมีสัดส่วนที่มากกว่าพื้นที่ที่ยังเป็นป่า
ชายเลน ดังนั้นพื้นที่ป่าชายเลนของทั้งจังหวัดฉะเชิงเทรา เขตอ้าเภอบางปะกง และจังหวัดสมุทรปราการ เขตอ้าเภออ้าเภอเมือง
สมุทรปราการและอ้าเภอบางบ่อ คือ พื้นที่บริเวณปากแม่น้้าเจ้าพระยาไปจนกระทั่งปากแม่น้้าบางปะกงมีพื้นที่ที่ประกอบด้วยใช้
ประโยชน์ของพื้นที่ที่หลากหลาย ไม่ว่าจะเป็นพื้นที่ของส่วนราชการ พื้นที่อยู่อาศัย พื้นที่ที่ถูกใช้ส้าหรับการอุตสาหกรรม พื้นที่ท้า
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การเกษตร พื้นที่การท้าประมง พื้นที่ป่าชายเลน พื้นที่ในบริเวณนี้จึงเป็นพื้นที่ที่มีความเสี่ยงที่จะเกิดการท้าให้ป่าชายเลนลดน้อยลง
หรือหมดสภาพไป เช่น โครงการบ่อบ้าบัดน้้าเสียคลองด่าน ที่มีการน้าพื้นที่จ้านวน 1,903 ไร่ มาใช้ส้าหรับท้าโครงการซึ่งเป็นการรุก
ล้้าที่ดินสาธารณะประโยชน์ การที่จะดูแลให้เกิดการคงอยู่หรือการเพิ่มขึ้นของป่าชายเลนในพื้นที่บริเวณนี้จะต้องเกิดจากการบูรณา
การของภาคส่วนที่เกี่ยวข้องมาร่วมกันด้าเนินกิจกรรมเพื่อให้เกิดการคงอยู่หรือเพิ่มขึ้นของป่าชายเลน ป่าชายเลนในบริเวณระหว่าง
ปากแม่น้้าเจ้าพระยาถึงปากแม่น้้าบางปะกงเป็นปา่ชายเลนที่อยู่ในบริเวณอ่าวไทยซึ่งเป็นพื้นที่ในการท้าประมงส้าคัญของประเทศไทย 
ป่าชายเลนในบริเวณนี้จึงมีผลต่อระบบนิเวศของอ่าวไทย เช่น เป็นแหล่งวางไข่ อนุบาลตัวอ่อนของสัตว์ในบริเวณนั้น  

เทคโนโลยีที่ใช้ในการวิจัยครั้งนี้คือระบบภูมิสารสนเทศในการก้าหนดต้าแหน่ง และดูภาพถ่ายจากดาวเทียม ซึ่ง GIS จะได้ทราบ

ติดตามข้อมูลเชิงพื้นที่เพื่อน้ามาข้อมูลเหล่านี้มาจัดการในด้านของทรัพยากร ดังนั้น GIS และ remote sensing ถือเป็นเครื่องมือทาง
เทคโนโลยีที่ส้าคัญในการส้ารวจเพื่อใช้เป็นข้อมูลส้าหรับการควบคุมติดตาม การวางแผนการจัดการ การวางนโยบาย การวิจัย และ การ
ตัดสินใจที่เห็นชอบร่วมกัน (Franklin, 1994) ดังเช่นส้านักงานพัฒนาเทคโนโลยีอวกาศและภูมิสารสนเทศ(องค์การมหาชน) ศูนย์ภูมิภาค
เทคโนโลยีอวกาศและภูมิสารสนเทศภาคใต้ (2552) ได้ด้าเนินโครงการการประยุกต์ใช้ข้อมูลระบบภูมิสารสนเทศเพื่อติดตามการเปลี่ยนแปลง
ชายฝั่งทะเลภาคใต้ฝั่งอ่าวไทย มีความยาว 1,067 กิโลเมตร ตั้งแต่จังหวัดชุมพรไปจนถึงจังหวัดนราธิวาส ด้วยการใช้ข้อมูลจากภาพถ่ายทาง
อากาศเปรียบเทียบกับภาพถ่ายดาวเทียม พบว่ามีทั้งพื้นที่ที่มีการกัดเซาะ และพื้นที่ที่มีการสะสมตัว มีการใช้มาตรการแบบอ่อนและแบบ
แข็งเข้าไปแก้ปัญหา แต่บางมาตรการกับสร้างปัญหาให้กับพื้นที่ข้างเคียง จากการศึกษามีพื้นที่กัดเซาะร้อยละ 12.93 พื้นที่สะสมตัวร้อยละ 
13.41 และมีพื้นที่ชายฝั่งคงสภาพร้อยละ 73.66 สาเหตุการกัดเซาะมาจาก คลื่น ลมมรสุม การขาดความสมดุลของตะกอน และกิจกรรมของ
มนุษย์  นอกจากนี้ ศุภลักษณ์ บาตรโพธิ์ และชนินทร์ ปราณีสอน (2560) ได้พัฒนาโปรแกรมประยุกต์ส้าหรับค้นหาและน้าทางไปยัง
ร้านอาหารในจังหวัดสมุทรสาคร โดยแสดงผลผ่านหน้าจออุปกรณ์เคลื่อนที่บนระบบปฏิบัติการไอโอเอส โปรแกรมพัฒนาขึ้นโดยใช้เทคโนโลยี 
GPS และมีการน้าเส้นทางโดยใช้แผนที่จาก Google Map  

ปัญหาดังกล่าวข้างต้นท้าให้ผู้วิจัยมีความสนใจที่จะท้าการศึกษาถึงการบริหารจัดการพื้นที่ของป่าชายเลนที่ก้าลังด้าเนินการอยู่
ในปัจจุบัน และการบริหารจัดการที่จะเกิดขึ้นในอนาคต ว่ามีการบริหารจัดการในรูปแบบใดมีภาคส่วนใดมีส่วนร่วมในการจัดการ มีหลักการ
ที่จะน้าไปสู่ความยั่งยืน ผู้ท้าการวิจัยท้าการศึกษาจากพื้นที่ระหว่างปากแม่น้้าเจ้าพระยากับปากแม่น้้าบางปะกง ซึ่งเป็นพื้นที่ส่วนหนึ่งของ
ชายทะเลอ่าวไทย ที่มกีารขยายตัวของภาคที่อยู่อาศัย ภาคอุตสาหกรรม ท้าให้มีการเข้าใช้พื้นที่บริเวณที่เป็นส่วนพื้นที่ป่าชายเลน 
 

วัตถุประสงค์การวิจัย 

เพื่อศึกษาการใช้ประโยชน์ท่ีดนิพื้นที่ป่าชายเลนปี พ.ศ. 2545 2552 และ ปี พ.ศ. 2560 บรเิวณพื้นทีร่ะหว่างปากแม่น้้า
เจ้าพระยาถึงปากแม่น้้าบางปะกง 
   

ประโยชน์ที่คาดว่าจะได้รับ 
 1. ทราบถึงการใช้ประโยชน์ท่ีดินพื้นที่ป่าชายเลนปี พ.ศ. 2545 และ ปี พ.ศ. 2560 บริเวณพื้นที่ระหว่างปากแม่น้้าเจ้าพระยา
ถึงปากแม่น้้าบางปะกง 
 2. เป็นแนวทางในการจัดการป่าชายเลนที่มีลักษณะเดียวหรือใกล้เคียงกัน และสามารถเป็นข้อมูลให้กับหน่วยงานที่เกี่ยวข้อง
และผู้ที่สนใจ 
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วิธีด้าเนินการวิจัย 
1.  ท้าการศึกษาตั้งแต่บริเวณชายฝั่งบ้านในคลอง จังหวัดสมุทรปราการ ไปจนถึง เกาะนก จังหวัดฉะเชิงเทรา การศึกษา

การจัดการป่าชายเลนระหว่างปากแม่น้้าเจ้าพระยาถึงปากแม่น้้าบางปะกงเป็นการศึกษาในพื้นที่ป่าชายเลนเริ่มตั้งแต่ปากแม่น้้า
เจ้าพระยา จังหวัดสมุทรปราการไปจนกระทั่งถึงปากแม่น้้าบางปะกง จังหวัดฉะเชิงเทรา ดังภาพที่ 1 

 

ภาพที่ 1  พื้นที่ศึกษา (Google Earth, 2561) 

 โดยพื้นที่ท่ีศึกษาตั้งแต่ปากแม่น้้าเจ้าพระยา จังหวัดสมุทรปราการไปจนกระทั่งถึงปากแม่น้้าบางปะกง จังหวัดฉะเชิงเทรา 
มีพื้นที่ 49.7 ตารางกิโลเมตร และความยาวรอบพื้นที่ 83.8 กิโลเมตร มีทิศเหนือ ติดกับทางหลวงหมายเลข 3 ทิศใต้ ติดกับทะเลอ่าว
ไทย พื้นที่ที่ศึกษา คือพื้นที่ป่าชายเลนในจังหวัดสมุทรปราการ และจังหวัดฉะเชิงเทรา ซึ่งได้แก่ ต้าบลบางปะกง ต้าบลสองคลอง 
อ้าเภอบางปะกง จังหวัด ฉะเชิงเทรา และ ต้าบลบางปู ต้าบลบางปูใหม่ อ้าเภอเทศบาลต้าบลบางปู ต้าบลคลองด่าน และต้าบลคลอง
ด่าน อ้าเภอเทศบาลต้าบลคลองด่าน จังหวัดสมุทรปราการ   

 2.  การศึกษาครั้งนี้ใช้เทคโนโลยภีมูิสารสนเทศดังนี้ 
  - ข้อมูลภาพถ่ายดาวเทียม ปี พ.ศ. 2545 2552 และ ปี พ.ศ. 2560 
  - ระบบสารสนเทศภูมิศาสตร์จ้าแนกการใช้ประโยชน์ที่ดิน และวิเคราะห์การเปลี่ยนแปลงของป่าชายเลนปี 
พ.ศ. 2545 2552 และ ปี พ.ศ. 2560 
 3.  การได้มาซึ่งข้อมูลภาพถ่ายดาวเทียม GEOEYE จาก Plugin ช่ือ Open Layer ในโปรแกรมระบบเปิด (Open Source) 
เพื่อใช้เป็นแผนที่ฐาน (Base Map) ส้าหรับการจัดเก็บข้อมูลภาพ (Capture) โดยมีขั้นตอนการท้าดังต่อไปนี้ 
  3.1 สร้างเส้นกริดขนาดความกว้างคูณยาวขนาด 400 x 500 เมตร ด้วยค้าสั่ง Vector > Research Tool >Vector 
Grid ซึ่งจะก้าหนดขอบเขตของกริด (Grid Extent) ตามขอบเขตของพื้นที่ศึกษา และก้าหนดค่า x,y เท่ากับ 400, 500 ตามล้าดับ โดย
โปรแกรมจะก้าหนดค่าโดยปริยาย (Default) ของหน่วย (Unit) ตามค่าพิกัดแผนที่ของขอบเขตพื้นที่ศึกษา  
   3.2 จัดเก็บภาพถ่ายดาวเทียม GEOEYE จากโปรแกรม QGIS ท้าได้โดยการเลือกกรดิที่ต้องการและขยาย
ภาพไปยังบรเิวณพื้นที่ดังกล่าวด้วยค้าสั่ง Zoom Map to The Selected Row หลังจากนั้นท้าการจดัเก็บภาพด้วยค้าสั่ง 
Project>Save as Image และบันทึกนามสกุลไฟลเ์ป็น .tiff  เพื่อเก็บค่าพิกัดของภาพที่ท้าการจัดเก็บ 
   3.3  ต่อภาพ (Mosaic Image) ถ่ายดาวเทียม GEOEYE ภายหลังจากการจัดเก็บข้อมูลภาพในขั้นตอนที่ 1.1.2 ให้เป็น
ภาพพื้นเดียวกันด้วยค้าสั่ง Raster>Miscellaneous>Merge และท้าการเลือกไดเร็กทอรี่ (Directory) ที่จัดเก็บภาพเพื่อเป็นข้อมูล
ส้าหรับการน้าเข้า 
   3.4 การปรับแก้ค่าคลาดเคลื่อนเชิงเรขาคณิต (Geometric Correction) เป็นการปรับแก้ค่าพิกัดแผนที่ (Map 
Coordinate) แบบภาพสู่ภาพ (Image to Image) โดยใช้ภาพแผนที่ออร์โธสีเป็นภาพอ้างอิงเพื่อก้าหนดจุดควบคุมภาคพื้นดิน 
(Ground Control Point) ตั้งแต่สี่จุดควบคุมขึ้นไป ซึ่งค่าคลาดเคลื่อนไม่เกิน 1 เมตรและอ้างอิง Datum เป็น WGS1984 
   3.5 การตัดภาพ (Clip Image) ด้วยขอบเขตพื้นท่ีศึกษา 
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 4.  การเตรียมข้อมูลจากดาวเทียม LANDSAT ก่อนการประมวลผล 
   4.1 การแปลงค่าเชิงเลข (Digital Number: DN) เป็นการแปลงค่าเชิงเลขจ้านวน 8 บิต และ 16 บิต ให้อยู่ในรูปแบบ
ของการสะท้อนแสง (Reflectance) เพื่อใช้ในการศึกษาดัชนีพืชพรรณ ด้วยการเขียนสมการคณิตศาสตร์ผ่านโปรแกรม QGIS แสดงได้
ดังสมการที่ 1 ส้าหรับดาวเทียม LANDSAT-7 และสมการที ่2 ส้าหรับดาวเทียม LANDSAT-8 

 𝜌 =
𝜋∙𝐿𝜆∙𝑑2

𝐸𝑆𝑈𝑁𝜆∙𝑐𝑜𝑠𝜃𝑠
 

 เมื่อ 𝑑2   คือ ระยะทางของโลกและดวงอาทิตย์ (Earth-Sun Distance) 
  𝐸𝑆𝑈𝑁𝜆  คือ การแผ่รังสีของดวงอาทิตย์ของแต่ละช่วงคลื่น  
  𝜃𝑠    คือ มุม Solar Zenith  
  𝐿𝜆    คือ การแผ่รังสีเชิงสเปกตรัมของแต่ละช่วงคลื่น 
   และ         𝜌 = 𝑀𝜌𝑄𝑐𝑎𝑙 + 𝐴𝜌   

 เมื่อ 𝜌     คือ ค่าการสะท้อนของแตล่ะช่วงคลื่น 
   𝑀𝜌    คือ ค่า Reflectance Multi Band  
   𝐴𝜌    คือ ค่า Reflectance Add Band 
   𝑄𝑐𝑎𝑙   คือ ค่าเชิงเลขของแต่ละจุดภาพ  
  4.2  การรวมแบนด์ (Composite Band) ภาพถ่ายดาวเทียมโดยเลือกช่วงคลื่นที่ 1-5 และ 7 ส้าหรับข้อมูลจาก
ดาวเทียม Landsat-5 และ Landsat-7    ช่วงคลื่นที่ 2-7 ส้าหรับข้อมูลจากดาวเทียม LANDSAT-8 การผสมสีของภาพ จะใช้สีผสม
เท็จ Landsat-5 และ Landsat-7   จะเป็นแบนด์ 4-5-3 (R:G:B)  Landsat-8 จะเป็นแบนด์ 6-5-4 (R:G:B)  โดย R คือ แม่สีสีแดง   G 
คือ แม่สีสีเขียว  B คือ แม่สีสีน้้าเงิน 
  4.3 การตัดภาพถ่ายดาวเทียม ด้วยขอบเขตพื้นท่ีศึกษา 
 5. การจ้าแนกการใช้ประโยชน์ท่ีดนิ 
  5.1 การวิจัยครั้งนี้เป็นการศึกษาการใช้ประโยชน์ท่ีดินในปี พ.ศ. 2545 2552 และ ปี พ.ศ. 2560 ด้วยวิธีการจ้าแนก
ด้วยสายตา (Head up Digitized) ด้วยโปรแกรม QGIS เนื่องจากเป็นวิธีการจ้าแนกที่ถูกต้องสูงและพื้นที่ศึกษามขีนาดไม่ใหญ่มาก แบ่ง
การใช้ประโยชน์ท่ีดินออกเป็น 5 ประเภท ได้แก่ พื้นที่ป่าชายเลน   พื้นที่เกษตรกรรม  พื้นที่ชุมชนเมือง พื้นที่อุตสาหกรรม   พื้นที่แหล่ง
น้้า  และพื้นที่อ่ืน ๆ   
  5.2 การประเมินความถูกต้องของการจ้าแนก (Accuracy Assessment) เพื่อตรวจสอบความถูกต้องของข้อมูลที่ได้จาก
การใช้ประโยชน์ท่ีดินเปรียบเทียบกับข้อมูลอ้างอิง (Reference Data) โดยใช้เทคนิคการสุม่ข้อมูลแบบอสิระ (Random Sampling) 
อ้างอิงกับข้อมูลจากการส้ารวจภาคสนาม โดยมีการประเมินความถูกต้องในรูปแบบของค่าความถูกต้องโดยรวม (Overall Accuracy) ซึ่ง
พิจารณาจากจ้านวนจุดที่จา้แนกได้ถกูต้องทั้งหมดหารด้วยจ้านวนจุดรวมทั้งที่จ้าแนกถูกต้องและไม่ถูกต้อง 
  5.3 การศึกษาการเปลีย่นแปลงการใช้ประโยชน์ท่ีดินด้วยวิธีการวิเคราะห์ซอ้นทับ (Overlay Analysis) แบบ Matrix 
Union เพื่อให้เห็นถึงการเปลี่ยนแปลงการใช้ประโยชน์ท่ีดินของพื้นที่ดังกล่าวว่ามีการเปลี่ยนแปลงจากประเภทใดไปเป็นประเภทใด 
 

ดังนั้นขั้นตอนการด้าเนินวิธีการวิจยัสามารถสรุปได้ดังภาพท่ี 2 

------------ สมการที่ 1 

------------ สมการที่ 2 
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ภาพที่ 2 สรุปกรอบวิธีการด้าเนินการวิจัย 

ผลการวิจัย 
ตารางที่ 1   การเปรียบเทียบการใช้ประโยชน์ท่ีดินในพ้ืนท่ีศึกษา อ้าเภอบางปะกง สองคลอง บางปูในปี พ.ศ. 2545 2552 

และ2560 (หน่วย:ไร่) 
ประเภท 

 
บางปะกง สองคลอง บางป ู

2545 2552 2560 2545 2552 2560 2545 2552 2560 

ป่าชายเลน 568.71 976.45 1104.93 227.57 603.83 901.76 228.66 467.10 438.04 

เกษตรกรรม   5133.85 4630.57 4118.17 5785.56 5296.00 5202.17 3040.68 2481.57 2001.93 

ชุมชนเมือง 267.90 368.40 638.88 290.95 582.33 640.22 724.17 918.80 1344.16 

อุตสาหกรรม 582.52 646.92 785.60 0.00 96.78 154.43 43.09 142.95 209.03 

แหล่งน้้า 329.75 368.40 406.42 745.26 772.25 723.96 261.21 229.44 216.38 

อื่นๆ 734.38 626.37 563.12 719.75 417.89 146.55 0.00 57.94 88.27 

รวม 7617.12 7617.12 7617.12 7769.08 7769.08 7769.08 4297.81 4297.81 4297.81 
 

ตารางที่ 2   การเปรียบเทียบการใช้ประโยชน์ท่ีดินในพื้นที่ศึกษา อ้าเภอบางปูใหม่ คลองด่านในปี พ.ศ. 2545 2552 และ
2560 (หน่วย:ไร่) 

ประเภท 
 

บางปูใหม ่ คลองด่าน 

2545 2552 2560 2545 2552 2560 

ป่าชายเลน 351.65 774.94 751.59 1561.23 1661.19 1971.04 

เกษตรกรรม 1298.61 635.75 451.04 7006.98 6737.73 5748.08 

ชุมชนเมือง 1595.39 1703.12 2044.89 1995.26 2154.80 2587.31 

อุตสาหกรรม 1776.15 2082.48 2108.42 40.86 114.90 335.77 

แหล่งน้้า 31.05 104.67 108.05 2121.16 2035.23 2016.47 

อื่นๆ 493.99 245.89 82.86 59.64 81.28 126.46 

รวม 5546.84 5546.84 5546.84 12785.12 12785.12 12785.12 
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 จากตารางที่ 1 และตารางที่ 2 จะพบว่าพื้นที่ป่าชายเลน พื้นที่อุตสาหกรรม พื้นที่ชุมชนเมือง มีจ้านวนพื้นที่
เพิ่มขึ้น ส่วนพ้ืนท่ีเกษตรกรรมมีพื้นท่ีน้อยลงใน ปีพ.ศ. 2560 เมื่อเปรียบเทียบกับ ปีพ.ศ. 2545 

 

ภาพที่ 3 แสดงการใช้ประโยชน์ท่ีดิน  บริเวณพื้นท่ีศึกษา ปี พ.ศ.2545 จากดาวเทียม Landsat 5 (ประดิษฐ  ดีใจ, 2561) 

 

ภาพที่ 4 แสดงการใช้ประโยชน์ทีด่ิน  บริเวณพื้นท่ีศึกษา ปี พ.ศ.2552 จากดาวเทียม Landsat 5 (ประดิษฐ  ดีใจ, 2561) 
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ภาพ
ที่ 5 แสดงการใช้ประโยชน์ท่ีดิน  บริเวณพื้นท่ีศึกษา ปี พ.ศ.2560 จากดาวเทียม Landsat 8 (ประดิษฐ  ดีใจ, 2561) 

 จากภาพที่ 3 ภาพที่ 4 และภาพที่ 5 แสดงให้เห็นการใช้ประโยชน์ที่ดินในปีพ.ศ. 2545 พ.ศ. 2552 และพ.ศ. 2560 ที่แยก

ตามการใช้ประโยชน์ท่ีดิน 6 ประเภท และแสดงให้เห็นว่าในช่วงเวลาดังกล่าวมีการเปลี่ยนแปลงการใช้ประโยชน์ท่ีดินเกิดขึ้น สังเกตได้
จากสีที่เปลี่ยนแปลง 
 

สรุปผล 
จากผลการศึกษาบริเวณป่าชายเลนระหว่างปากแม่น้้าเจ้าพระยาถึงปากแม่น้้าบางปะกง จากปีพ.ศ.2545 2552 

จนถึง 2560พบว่าในภาพรวมบริเวณป่าชายเลนในบางพื้นที่ที่ศึกษาจากปี พ.ศ.2545 ถึง 2552 มีพื้นที่เพิ่มขึ้น 52.61% และ
จากปี พ.ศ. 2552 ถึง 2560 มีพื้นที่เพิ่มขึ้น 15.25 % ในบริเวณพื้นที่ที่เป็นชุมชนเมืองก็มีแนวโน้มการใช้ประโยชน์ที่ดินเพิ่มขึ้น 
โดยในปี พ.ศ.2545 ถึง 2552 มีพื้นที่เพิ่มขึ้น 17.52% และจากปี พ.ศ. 2552 ถึง 2560 มีพื้นที่เพิ่มขึ้น 26.68%  นอกจากนี้
พื้นที่อุตสาหกรรมก็มีแนวโน้มการใช้ประโยชน์ที่ดินเพิ่มขึ้น โดยในปี พ.ศ.2545 ถึง 2552 มีพื้นที่เพิ่มขึ้น 26.26 % และจากปี 
พ.ศ. 2552 ถึง 2560 มีพื้นที่เพิ่มขึน้ 16.51%  ในขณะที่ พื้นที่เกษตรกรรม มีแนวโน้มการใช้ประโยชน์ที่ดินลดลง โดยในปี พ.ศ.
2545 ถึง 2552 มีพื้นที่ลดลง 11.16% และจากปี พ.ศ. 2552 ถึง 2560 มีพื้นที่ลดลงอีก 11.43%   และการใช้ประโยชน์ที่ดิน
ในส่วนของอื่นๆ มีแนวโน้มการใช้ประโยชน์ที่ดินลดลงเช่นกัน โดยในปี พ.ศ.2545 ถึง 2552 มีพื้นที่ลดลง 28.81% และจากปี 
พ.ศ. 2552 ถึง 2560 มีพื้นที่ลดลงอีก 29.53%  ส่วนพื้นที่ที่เป็นแหล่งน้้ามีแนวโน้มการใช้ประโยชน์ที่ดิน ไม่คงที่ โดยในปี พ.ศ.
2545 ถึง 2552 มีพื้นที่เพิ่มขึ้น 0.62% แต่จากปี พ.ศ. 2552 ถึง 2560 มีพื้นที่ลดลงอีก 1.10%    
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อภิปรายผลการวิจัย 
ปัจจุบันหากกล่าวถึงเทคโนโลยีที่เหมาะสมที่สุดที่น้ามาใช้ในการส้ารวจป่าชายเลน หนึ่งในเทคนิคที่มีประสิทธิภาพที่สุด

คือการใช้ เทคโนโลยีภูมิสารสนเทศ (Geospatial Information Technology)  ซึ่งประกอบด้วย Geographical Information 
Systems (GIS), Global Positioning System (GPS) และ Remote Sensing (RS) การใช้เทคโนโลยีเหล่านี้จะผสานรวมแผนที่
แบบต่าง ๆ รวมถึงภาพถ่ายดาวเทียม ที่แสดงถึงสภาพแวดล้อมของแต่ละภูมิภาค การก้าหนดต้าแหน่ง และการจัดต้าแหน่งที่
เหมาะสมส้าหรับการอนรุักษแ์ละการฟื้นฟู สามารถก้าหนดและตรวจสอบได้ดี ส้าหรับการท้าแผนที่และการตรวจหาชนิดของป่า
ชายเลนแต่ละชนิดเพื่อการปลูกป่า และการบริหารพื้นที่โดยรอบป่าชายเลนเพื่อหาแนวทางการอยู่รวมกันอย่างยั่งยืนต่อไปใน
อนาคต 

การเปลี่ยนแปลงการใช้ประโยชน์ท่ีดินในพื้นที่ศึกษาพบว่าการเปลี่ยนแปลงของการใช้ประโยชน์ที่ดินมีการเปลี่ยนแปลง
ในหลายการใช้ประโยชน์ที่ดินมีลักษณะการเปลี่ยนแปลงที่เปลี่ยนกลับไปมาได้ เช่น การเปลี่ยนจากป่าชายเลนเป็นพื้นที่
เกษตรกรรม และเปลี่ยนกลับมาเป็นป่าชายเลน ก่อนที่จะมาเป็นพื้นที่แหล่งน้้า เป็นต้น จากผลการศึกษาพบว่าพื้นที่เกษตรกรรม
เปลี่ยนแปลงการใช้ประโยชน์ไปเป็นการใช้ประโยชน์ในรูปแบบอื่นมากที่สุด และพื้นที่อุตสาหกรรมกลับเพิ่มขึ้นแสดงให้เห็นว่า
พื้นที่ศึกษามีการประกอบอาชีพทางด้านเกษตรกรรมลดลงแต่การประกอบอาชีพทางด้านอุตสาหกรรมเพิ่มขึ้น ส่วนพื้นที่ป่าชาย
เลนที่เพิ่มขึ้นเป็นการแสดงให้เห็นถึงความใส่ใจด้านสิ่งแวดล้อมในพื้นที่ได้ทางหนึ่ง ส่วนการเพิ่มขึ้นของพื้นที่ชุมชนเมืองก็เป็นไป
ในทิศทางเดียวกันกับการเพิ่มขึ้นของพื้นที่อุตสาหกรรมที่เมื่อมีการประกอบอุตสาหกรรมย่อมมีการเพิ่มขึ้นของพนักงานที่จะต้อง
เข้ามาท้างานที่อยู่อาศัยจึงเป็นปัจจัยส้าคัญที่ตามมา 

ดังนั้นการจัดการปา่ชายเลนอย่างยั่งยืนควรมีการก้าหนดนโยบายดังนี้ 
1.  จะต้องมีการก้าหนดแผนยุทธศาสตร์การจัดการระบบนิเวศของป่าชายเลนโดยการพิจารณาถึงด้านกายภาพ เศรษฐกิจ 

และสังคม นโยบาย และข้อบังคับที่มีอยู่ การระบุปัญหา(การวิเคราะห์มิติการจัดการอย่างยั่งยืน) และสนับสนุนผู้มีส่วนได้เสีย 
2.  เพื่อสนับสนุนการด้าเนินการตามแผนยุทธศาสตร์การจัดการระบบนิเวศของป่าชายเลนในท้องถิ่นควรกระท้าเพื่อ

ความเข้มแข็งดังนี ้
2.1  การจัดตั้งสถาบันวิจัย หรือศูนย์การเรียนรู้ป่าชายเลนในท้องถิ่นและจัดท้าแผนยุทธศาสตร์การจัดการระบบนิเวศ

ของป่าชายเลนระดับชุมชน  
2.2  ส่งเสริมให้มีหน่วยงานจัดการป่าชายเลนของชุมชน และให้ความส้าคัญกับความยั่งยืน เช่น การท่องเที่ยว 

ทางเลือกในการบริโภคอาหาร การเพาะปลูกที่เป็นมิตรกับสิ่งแวดล้อม  เป็นต้น 
3.  ชุมชนที่อาศัยอยู่ติดกับป่าชายเลนคือ ผู้รับประโยชน์ที่ส้าคัญ แม้ว่าจะไม่มีกรรมสิทธิ์ตามกฎหมายอย่างเป็น

ทางการก็ตาม แต่ชุมชนจะเป็นคนที่พึ่งพาอาศัยป่าชายเลนมากที่สุด  ชุมชนเป็นกลุ่มคนที่จะประสบปัญหาหรือได้รับประโยชน์
สูงสุดจากการเปลี่ยนแปลงของป่าชายเลน ดังนั้นการมีส่วนร่วมของชุมชนท้องถิ่นในการอนุรักษ์ป่าชายเลน เป็นสิ่งส้าคัญต่อ
ความส้าเร็จของการจัดการป่าชายเลนในชุมชน การระบุผู้มีส่วนได้ส่วนเสีย และการวิเคราะห์การออกแบบการท้างานร่วมกัน การ
ก้าหนดข้อตกลงและการอ้านวยความสะดวกในการมีส่วนร่วมอย่างเท่าเทียมกันในการก้าหนดนโยบายและการจัดการป่าชายเลน
เป็นสิ่งที่จะท้าให้เกิดความยั่งยืนในอนาคต  การสนับสนุนให้ชุมชนท้องถิ่นเข้ามาพัฒนาวิถีชีวิตอยู่ร่วมกับป่าชายเลน ทดแทนวิถี
ชีวิตแบบเดิมที่มุ่งเน้นท้าลายป่าชายเลน เช่นตัดไม้ท้าลายป่า ชุมชนควรมีการให้ความรู้เพื่อมีวิถีชีวิตทางเลือกที่สามารถอยู่
ร่วมกับป่าชายเลนในเชิงการใช้ประโยชน์จากป่าชายเลนในขณะเดียวกันก็ไม่ท้าลายป่าชายเลนเช่นกัน เช่น การเก็บเกี่ยวหอย
นางรม  การประมงตามช่องทางและการเพาะเลี้ยงสัตว์น้้า ผลิตภัณฑ์จากป่าไม้ และการเลี้ยงผึ้ง (การผลิตน้้าผึ้ง) ซึ่งสิ่งเหล่านี้จะ
ส่งเสริมให้เกิดระบบวนเกษตรและการอนุรักษ์ของป่าชายเลน 
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4.  การก้าหนดพื้นที่อนุรักษ์ป่าชายเลนเพื่อท่ีได้รับการป้องกันเป็นเครื่องมือการจัดการป่าชายเลนที่ใช้กันอย่าง
แพร่หลายที่สามารถช่วยป้องกันการสูญเสียและความเสื่อมโทรมของป่าชายเลนในสถานที่เฉพาะเจาะจง  

5.  การท่องเที่ยวเชิงนิเวศสามารถประยุกต์ใช้กับระบบนิเวศของป่าชายเลนได้อย่างมีประสิทธิภาพเพื่อสร้างรายได้และ
การจ้างงานส้าหรับท้องถิ่น ในด้านความยั่งยืนของเศรษฐกิจ ชุมชนสามารถใช้การท่องเที่ยวเชิงอนุรักษ์ป่าชายเลนเผยแพร่
ประชาสัมพันธ์และการศึกษากิจกรรมการท่องเที่ยวเชิงนิเวศป่าชายเลน ได้แก่ ทัวร์เรือ เดินป่า พายเรือคายัค ดูนกและตกปลา 
รวมถึงการดูทัวร์สัตว์ป่าของสายพันธุ์ที่พบในบริเวณที่อยู่อาศัยของป่าชายเลน  หรือการจัดเทศกาลชมพันธุ์ไม้ที่จะมีเฉพาะ
ฤดูกาลในป่าชายเลน ซึ่งกิจกรรมเหล่านี้สามารถสร้างรายได้อย่างมีนัยส้าคัญ 

ด้านการจัดการพื้นท่ีป่าชายเลนในพ้ืนท่ีศึกษาเดิมมีการจัดการในรูปแบบท่ีไม่มีการประสานงานกันอย่างมีระบบ 
หน่วยงานราชการในระดับท้องถิ่นมีงบประมาณในการบริหารจัดการน้อยท้าให้ต้องแบ่งงบประมาณไปจัดการในด้านอื่นๆของ
ท้องถิ่นด้วย อีกทั้งโครงการใหญ่ที่เข้ามาในพื้นที่เป็นการด้าเนินโครงการจากหน่วยงานราชการในระดับที่ใหญ่กว่า เช่น ระดับ
กระทรวง รัฐบาล หน่วยราชการในพื้นที่จึงเป็นแค่หน่วยงานที่คอยอ้านวยความสะดวกไม่สามารถเข้าไปบริหารจัดการได้แต่อย่าง
ใดจึงมีบางโครงการที่ไม่ได้ให้ประโยชน์จริงตามความคาดหมายผลของโครงการ ซึ่งผลการศึกษาครั้งนี้มีลักษณะสอดคล้องกับ
การศึกษาของกอบกุล รายะนาคร ( 2550, หน้า 219 – 227 ) ในการหารูปแบบการจัดการป่าชายเลนในพื้นที่ศึกษา และได้พบ
ปัญหาเรื่องของปัญหาการมีส่วนร่วมของประชาชนในการจัดการทรัพยากรและสิ่งแวดล้อม ปัญหาการขาดแคลนเอกภาพในการ
จัดการสิ่งแวดล้อม และปัญหาการกระจายอ้านาจและความพร้อมขององค์กรปกครองส่วนท้องถิ่น  การวิจัยครั้งนี้เมื่อเข้าไป
ท้าการศึกษาและรวมความคิดเห็นในการจัดการป่าชายเลนได้ข้อสรุปในการจัดการพื้นที่จ้านวน 9 ข้อ น้ามาจัดท้าเป็นโมเดลการ
จัดการพื้นที่ป่าชายเลนระหว่างปากแม่น้้าเจ้าพระยาถึงปากแม่น้้าบางปะกง ภายใต้ยุทธศาสตร์กระทรวงทรัพยากรธรรมชาติและ
สิ่งแวดล้อม ระยะ 20 ปี ด้วยการท้างานร่วมกันของทุกภาคส่วนของพื้นที่ด้วยข้อก้าหนดที่ออกโดยความคิดเห็นร่วมกันของทุก
ภาคส่วนในพื้นที ่
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